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1

Migration of SAP Enterprise Portal 6.0 to
NetWeaver '04

Purpose
This document describes how to migrate the portal (referred to in this guide as EP) and
Knowledge Management (KM) from Enterprise Portal 6.0 SP2 to NetWeaver ’04.
In terms of infrastructure, the migration transports portal and KM content from J2EE Engine 6.20
and adapts them to the more advanced Java application server, J2EE Engine 6.40.
The Migration Project
Migration from EP 6.0 to NW ’04 is an important undertaking and is to be approached as a
serious project, including extensive preparation and some downtime. Documentation and SAP
Notes should be read with appropriate attention.
Required Expertise Resources
To perform a successful and efficient migration expert knowledge in the following area is required
or must be available:
•

Application knowledge: specifically, the portal and KM

•

Database administrator

•

OS administrator

Registration
The migration procedure requires registration by means of a registration key. This is in order to
enable SAP to provide proper support for your migration project.
Scope of the Migration Process
Migrate all EP 6.0 and KM database content to NetWeaver ’04 SR1.

The migration process deletes the content that was on the target system (NW ’04
SR1) database prior to migration, including portal content objects (whether native,
newly created, or imported) and configurations of any kind. Migration does not
merge content.
Database and Disk Space Prerequisites
•

The temporary table space on the target system must be at least twice the size of the
source database size.
Most new relational database management system installations have an auto-expand
feature for the temporary table space. The flag for this feature must be on. For MS SQL
Server, this flag is on by default, but this should be verified.

•

Free disk space, or free space on the file system for Unix, on the target system, should be
at least the size of the source system database.

Limitations
•

It is not possible to migrate from one operating system to another, or from one relational
database management system to another.

Although the migration process does not support migration across different
operating systems or relational database management systems, for customers who
want to switch operating systems and/or databases, SAP provides a tool (the NW
copy ) that is capable of copying database content and adapting it as required,
according to operating system, database management system, or both.
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Using the NW copy tool to switch OS or DB, or both, must be done only after the
migration process is completed.
For detailed information on the NW Copy tool, see Homogeneous and
Heterogeneous System Copy for SAP Systems Based at SAP Web Application
Server Java 6.40 SR1, located at service.sap.com/instguidesnw04 → Installation.
•

The migration does not support changes to UME configurations. The NW ’04 user
management configuration must be the same as that of the source EP 6.0 SP2 system.

•

The automatic migration process is a database export/import, from the source system to
the target. Changes made in the source portal, which are contained in the file system (for
example, the graphic image on the portal logon screen) are not migrated. Such changes
must be redone in the target portal.

•

Web Report tables are not migrated from EP 6.0 SP2 to NW04; therefore, Web Report
iViews will not work in the NW ‘04 portal.
The more advanced NW ’04 Portal Activity Report feature replaces the EP 6.0 SP2 Web
Report, and the differences are such that the data collected by the EP 6.0 Web Report
cannot be used in the target system.

Leaving the old .PAR files containing Web Report is harmless. See J2EE Engine
and Content with Code [Page 46] if you wish to remove them.
List of Relevant SAP Notes
The SAP notes contain the most recent installation information, as well as corrections to the
installation documentation. Read the installation SAP note before beginning the installation.

Make sure that you have the most recent version of the SAP Note. Find the SAP
Notes related to SAP Enterprise Portal in SAP Service Marketplace, at:
http://service.sap.com/nw04doc → SAP Notes
For all SAP Notes, or for search by number, go to:
http://service.sap.com/notes
SAP Note Number

Title

732458

Migration Enterprise Portal 6.0 SP2 to NW '04 Central Note

766765

Central Note – SAP EP 6.0 on Web AS 6.40
Release NW ‘04 SR1

Additional Documentation
For information about upgrading to the NW ’04 security zone concept, see the guide entitled How
To Upgrade to the Extended Security Zone Concept of NetWeaver ’04, located on SAP Service
Marketplace at service.sap.com/nw-howtoguides → Portal, KM and Collaboration.
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1.1

Overview - The Migration Process

Process
The migration process differs, depending on the components that are installed and the migration
path that you choose.
The migration process has five main phases:
...

1. Installation on the target machine
In preparation for the migration, you install NetWeaver ‘04 SR1 on the target machine.
The target machine must have the same components as the source machine. For example,
if the source machine has a portal and Knowledge Management installation, you must
install both these components on the target machine.

It is not necessary to re-import business packages, which were imported to EP 6.0
SP2. This content is migrated.
For more information about the installation procedure, see Installation of the Target System
- NetWeaver '04 SR1 [Page 15].
2. Pre-Migration Activities
There are pre-migration steps that must be performed prior to the migration process. The
portal and Knowledge Management each have their own specific set of pre-migration steps.
See the section, Preparations [Page 19] for the KM pre-migration information, and
Preparing for the Portal Migration [Page 31] for the portal.

If you are working with and migrating Knowledge Management, you must perform all
the pre-migration steps, for both the portal and KM, prior to the entire migration
process.
This is because KM requires updated information from the portal in order to migrate
successfully.

Do the portal pre-migration steps before the preparations for the KM migration. This
is to maintain a proper workflow, since the portal must be live for the its premigration steps and the KM pre-migration requires you to shut down the portal.
3. Migration of Knowledge Management
If Knowledge Management is installed on the source system, then you must begin with the
migration of this component. If Knowledge Management is not installed, you can begin with
the migration of the portal.
For more information, see Knowledge Management Migration [Page 17].
4. Migration of the portal
For more information, see Portal Migration [Page 30].
5. Post Migration Activities
After completion of the migration processes for both KM and the portal, perform all required
post-migration procedures. For detailed information, see Post-Migration Activities [Page
40].
Migrating from a Clustered Configuration
...

1. If you want to migrate to a clustered configuration for NW ‘04, first migrate to the central
instance of the target system, making sure that the J2EE Engine is shut on all the other
instances in the cluster.

Migration of SAP Enterprise Portal 6.0 to NetWeaver '04

9

2. After completing the migration, restart the J2EE on all other instances. The migrated
content is replicated automatically from the central instance.
For detailed information about J2EE Engine clustering, see help.sap.com → Documentation →
SAP NetWeaver → Release ‘04 → <Language> → SAP NetWeaver → Application Platform (SAP
Web Application Server) → Java Technology in SAP Web Application Server → Administration
Manual → Server Administration → Architecture Manual → Java Cluster Architecture.
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1.2

Checklist for EP 6.0 to NW '04 Migration

Use
Migrating SAP Enterprise Portal involves a complex collection of activities, including preparatory
and post-migration activities. The migration activities performed may not be identical for all,
depending on the EP installation and configuration, for example, if KM is not installed with the
portal.
The checklist shows all the activities needed to perform the migration to NW ’04 SR1, in
sequential order. The Conditions column tells you whether or not the specific activity is relevant
for you. Use it to make sure that all required actions are performed in the correct order.
Procedure
For the sake of clarity, the activities in this guide are largely organized and divided according to
KM and portal activities. This does necessarily mirror the correct sequence of performance. The
activities referred to in the checklist should be performed in the order they are listed, skipping
those that are not relevant to your system.
It is recommended to print the checklist and follow through the activities, checking them off as
they are completed.
Migration checklist

;

Migration Activity

Condition

Install NetWeaver ’04 SR1. See Installation of the Target
System - NetWeaver '04 SR1 [Page 15]
Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.
Perform user management configuration as described in
SAP Note 777640.

For portal, only if the user
management engine on the
target system is to use an
LDAP directory as the data
source for user information

Verify the prerequisites to migration as described in:
Migration of SAP Enterprise Portal 6.0 to NetWeaver '04
[Page 1]
Knowledge Management Migration [Page 17]
Portal Migration [Page 30].

Prerequisites for KM, on
condition it is installed

Read the central note for this migration path, SAP Note
732458.
It is also recommended to review, before starting the
migration, the troubleshooting document attached to SAP
Note 777176. This document is updated from time to
time, and it may contain valuable tips and workarounds.
Obtain a registration key by following the instructions
written in SAP Note 854791.
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Portal pre-migration
Delete principals in an unsupported case from the source
EP 6.0 SP2 portal user management, and create new
users and/or groups having identical properties. See
Preparing User Management Configuration for Migration
[Page 31].

The EP 6.0 SP2 user
management has the
principals “Administrator” user
“Guest” user, ”Administrators”
group,”Guests” group in a
case other than as shown
here.

Download the EP 6.0 SP2 user management
configuration. See Downloading the User Management
Configuration for Migration [Page 33].
Set the environment variables: JAVA_HOME and
DISPLAY. See Portal Migration [Page 30].

Unix OS

Install a configured Oracle Administrative Client on the
target machine. See Installing a Configured Oracle Client
[Page 34].

Working with Oracle database
server

Verify SDM configuration to avoid deployment failures.
See Verify/Preconfigure SDM [Page 36].
KM pre-migration
Verify the correct source system as described in
Checking the Source Version [Page 19].

EP 6.0 SP2 installation
includes KM

Find out the database name for later use. See
Determining the Database Name [Page 19].

‘’

Find out the system Ids as described in Determining
System IDs [Page 20].

‘’

Perform actions required for the Universal Worklist. See
Pre-Migration Universal Worklist Steps [Page 20]

“

Download the KM migration tool. See Obtaining the
Migration Software [Page 21].

‘’

Obtain patch 3 for Content Management and
Collaboration and apply it to the target system. See
Obtaining and Applying Patch 3 [Page 22]

“

Shut down the portal as described in Shutting Down the
Portal [Page 22].

‘’

Before running the migration exporter tool, see Backing
Up the etc Directory on the Target System [Page 22].

‘’

Copy the file system data of local fsdb repositories from
the source to the target system. See Copying Data for
Local fsdb Repositories [22]

‘’

Run the migration exporter tool on EP 6.0 SP2 as
described in Running the Migration Exporter Tool on the
Source System [Page 23].

‘’
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KM migration
Follow the instructions for Using the Migration Tool [Page
24] for KM.

EP 6.0 SP2 installation
includes KM

Run reports for the KM migration. See Running Reports
[Page 25].

‘’

Merge and copy the etc directory to the target portal. See
Merging the Contents of the etc Directory [Page 26].

‘’

Run the database migration tool for KM. If fsdb
repositories are configured, also use the tool to
synchronize the fsdb data that is located on the file
system and in the database. See Migrating the Database
[Page 27].

‘’

Perform the KM configuration migration as described in
Migrating the Configuration [Page 28]

‘’

Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.
Portal migration
Begin migrating the portal as described in Migrating the
Portal [Page 37]
Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.
Supplementary Tasks
On target system, perform Java system copy as
documented in Homogeneous and Heterogeneous
System Copy for SAP Systems Based at SAP Web
Application Server Java 6.40 SR1, located at
service.sap.com/instguidesnw04 > → Installation.

Only if it your project includes
switching OS or DB, or both

Upgrade target system to the latest version (SP Stack or
higher).
Recreate Collaboration rooms. For information, see
help.sap.com → Documentation → Language (English)
→ SAP NetWeaver → People Integration →
Collaboration.

Only if your source system
used Collaboration

KM post-migration
Deploy KM SDAs. See Deploying KM Software
Components [Page 40]
For additional manual migration steps, see Performing
Tasks Identified by Reports [Page 41]
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Delete irrelevant KM system IDs as described in Deleting
System IDs [Page 41]

‘’

Perform the post-migration activities related to UWL. See
the following sections:
Post-Migration Universal Worklist Steps [Page 42]
Post-Migration Workflow Steps [Page 43]

Using Universal Work List with
KM

Manually initialize ad hoc workflow objects. See
Initializing Workflow Templates and Object Types [Page
43]

‘’

Portal post-migration
Adjust properties in order to work with Crystal Reports
and R/3 systems. See Connecting to R/3 Systems and
Crystal Reports [Page 45].
Update authentication for Working with Back-End
Systems [Page 45].

Authorization by means of
logon tickets

Update the Reverse Proxy Filter Configuration [Page 46].

Web.xml parameter values
have been changed

For adjusting J2EE Engine custom configurations and
enabling work with custom code content, see J2EE
Engine and Content with Code [Page 46]

EP 6.0 SP2 includes userdeveloped content and/or
changes to J2EE Engine
configuration

Verify the integrity of user management persistence. See
Editing a Data Source Configuration File for UME
Persistence [Page 46]

Changes made to existing
datasource configuration file

Upgrade the KM initial permissions. See Upgrade the
Initial KM Permissions File [Page 47].

EP 6.0 SP2 installation
includes KM

For manual migration information and additional
information, see Theme Personalization, Logging, and
Miscellaneous Properties [Page 47]

Required copy of property files
Changes made to portal
theme, TLN properties, PCD
startup properties
Need new logging information

Update the NW ’04 version after migration. See
Installation of NW '04 Upgrades [Page 47]

Releases of NW ’04 upgrades
higher than the version at
which the migration process
finishes
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1.3

Installation of the Target System - NetWeaver '04
SR1

Prepare the target system for your migration, by installing NW '04 - SAP Enterprise Portal on Web
AS 6.40.

1.3.1

Planning the Target System

You cannot migrate to a target system on a different operating system from the one on which the
source system resides.
You must migrate to a target system that works with the same relational database management
system (RDBMS) as the source system.
Supported Source and Target Systems
EP 6.0 SP2

NetWeaver '04 SR1

Win 2000/ MS SQL 2000

Win 2000/ MSSQL 2000

Win 2003/ MS SQL 2000

Win 2003/ MSSQL 2000

Win 2000/ Oracle 9.2.0.6

Win 2000/ Oracle 9.2.0.6

Win 2003/ Oracle 9.2.0.6

Win 2003/ Oracle 9.2.0.6

AIX 5.2 / Oracle 9.2.0.6

AIX 5.2 / Oracle 9.2.0.6

HP-UX 11(i) / Oracle 9.2.0.6

HP-UX 11(i) / Oracle 9.2.0.6

Solaris 8&9 / Oracle 9.2.0.6

Solaris 8&9 / Oracle 9.2.0.6

If you are working with an MS SQL Server database, which is not installed on the
NW ’04 target machine, you must install on the target an MS SQL client of at least
the same version as the database server.

1.3.2

Installing SAP Enterprise Portal on the Target System

Obtaining a running SAP Enterprise Portal on Web AS 6.40 requires the following steps:
...

1. Install the NW '04 SR1
See the guide Installation Guide - SAP Enterprise Portal 6.0 on Web AS 6.40, located at
service.sap.com/instguidesNW04 → Installations.
2. Install Knowledge Management and Collaboration for NW ’04 SR1.
You install exactly the same components on the source and the target system. If the
source system only has a portal installation, then install only the portal now and, if
desired, add Knowledge Management and Collaboration after successfully
completing the migration.
After the installation of Knowledge Management and Collaboration, install the latest patch
that is available. Due to redeployment of software during the migration, it is necessary to reinstall this patch after the completion of the portal migration.
Additional Information
The target system for the migration is NW ’04 SR1 (equivalent to SP9) together with the latest
SP9 patch installed on top of it.
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After the target system has been installed and the migration completed, do not
upgrade the target system to SP Stack 10. Doing so will result in loss of some
functionality that was attained by a successful migration. If, after migration, upgrade
to a higher version than NW ’04 SR1 is desired, install NW ‘04 SP Stack 11, or
higher, when available.
For KM, part of the migration process includes the redeployment of software
components that are SR1-specific; therefore install updates, such as patches and
hot fixes, only after migration is finished.
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2

Knowledge Management Migration

Purpose
The migration transfers the content of Knowledge Management from an EP6.0 SP2 system to a
NW04 SR1 system.
Prerequisites
SAP Enterprise Portal and Knowledge Management are installed on the target machine and have
the version SAP NetWeaver ‘04 SR1.
Process Flow

Before you begin the migration, read SAP Note 732458. It contains the latest
information on the migration, including corrections to this guide.
When you migrate Knowledge Management, you need to:
•

Migrate Content Management and Collaboration.
This automatically includes the migration of the Universal Worklist (UWL).

• Migrate TREX Retrieval and Classification to TREX 6.1 Service Release 1.
You migrate Content Management and Collaboration before you migrate the portal.
Migration of Content Management and Collaboration
The migration of Content Management and Collaboration involves a number of steps, which are
explained in detail in this guide. The list below gives you an overview of the steps and shows the
order in which they must be performed. If Content Management and Collaboration is installed on
a cluster configuration, then the migration procedure is the same as for a standard configuration.
However, after the migration, it is necessary to delete old system IDs and check the assignment
of scheduled tasks to systems. For detailed instructions on individual steps in the following list,
see the corresponding sections later in the guide.
...

1. Preparations [Page 19]
a. Acquire a registration key, by following the instructions written in SAP Note 854791.
b. Make sure the source system has the version EP6.0 SP2 with the patch and hot fix
level specified in the central SAP Note for the EP 6.0 migration 732458.
c. Make a note of the CM database name on the source system.
d. Make a note of the system ID on the source system.
Cluster only:
In a cluster configuration, there are several system IDs.
e. Perform preparatory steps for the Universal Worklist.
f. Download the software for the migration from the SAP Software Distribution Center.
g. Download and apply patch 3 for Content Management and Collaboration SPS09 on
the target system.
h. On the source and target system, shut down the portal. Leave it shut down on both
systems for the entire migration.
i. On the target system, back-up the etc directory.
j. Copy the file system data of local fsdb repositories from the source system to the
target system.
k. On the source system, run the Migration Exporter tool. The tool stores data from the
source system in an archive file MigrationInput.zip, which you need later for
the migration on the target system. It:
i. Exports the KMC configuration data
ii. Collects system data for the migration
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2. The Migration [Page 24]
a. On the target system, extract the KMC Migration Tool to a temporary folder.
b. Copy the file MigrationInput.zip containing input data for the migration from
the source system to the folder with the KMC Migration Tool on the target system.
c. Use the KMC Migration Tool to:
i. Run reports that identify additional actions that are required for the migration.
ii. Merge the contents of the EP6.0 and NW ‘04 etc directories.
iii. Migrate the database content and synchronize data for fsdb repositories.
iv. Merge the EP6.0 and NW ‘04 configuration data.
3. Post-Migration Activities [Page 40]
A number of actions are necessary to complete the Knowledge Management Migration.
You perform the actions on the target system.

a.

b.

c.
d.
e.

You perform these steps after you have finished the portal migration .
Analyze the Customer Component and Repository Managers reports that are
generated by the KMC Migration Tool at the beginning of the migration. Perform the
manual migration tasks you identify in the reports that are necessary to complete the
migration.
Delete obsolete system IDs:
In a system with a single instance, delete the obsolete NW ’04 system ID.
In a cluster, delete old system IDs and then ensure that scheduled tasks are
assigned to new NW ‘04 system IDs.
Perform post-migration tasks for Universal Worklist
Perform post-migration tasks for workflow
Initialize templates for workflow

Migration of TREX to EP6.1 SR1
You can migrate TREX before or after the Content Management and Collaboration migration. For
the migration, you install the new TREX 6.1 SR1 version on the same machine as the old TREX
installation. You then migrate the indexes from the old system to the new system.
For more information about the migration procedure, see SAP Service Marketplace at
service.sap.com/instguidesnw04 → Upgrade → Cross-NW → Component Migration
Guide - Search and Classification (TREX)

When you follow the instructions in the migration guide, make sure that you
establish the connection between TREX and the Knowledge Management
application (the client). To do this, you need to configure the TREX Service in the
SAP J2EE Engine Visual Administrator Tool.
Results
The Content Management and Collaboration migration moves the EP6.0 database content and
configuration to the NW ‘04 system and updates them. The EP6.0 configuration data is
transferred from the file system into the NW ‘04 database.
Note that the repositories configured in the EP6.0 system will not be accessible on the target
system. To make them accessible, you need to perform the additional actions that are specified in
the results of the Repository Managers report which checks the repositories.
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2.1

Preparations

Purpose
Before you begin the migration, you need to perform a number of preparatory steps.

2.1.1

Checking the Source Version

Use
The source system for the migration must have the version CM 6.0 SP2 with the latest patch.
Before you start the migration, ensure that you have the correct version on the source system.
Prerequisites

Check SAP Note 732458 to find out the patch and hot fix level that is required for the
source system.
Procedure
...

1. Log on to the portal and choose System Administration → Support → Version.
2. Make sure that the patch and hot fix version that is specified in SAP Note 732458 is
displayed. Note that the last 2 figures indicate the patch and hot fix version:
6.0.2.<patch_level>.<hotfix_level>_ContentManagement_Collaboration
If a lower patch version than required is displayed, then you do not have the correct source
version for the migration. In this case, you must update the system before proceeding with
the migration.
If a higher patch version is displayed, you can perform the migration.

2.1.2

Determining the Database Name

Use
Before the migration make sure that you know the name of the CM database. You need to specify
the name when you migrate the database with the migration tool.
Procedure
to specify the name when you migrate the database with the migration tool.On the source system ...

If you are certain that the system uses the default database name wcm, you can skip
this procedure:
...

1. In the portal, access the connection pools with System Administration → System
Configuration → Knowledge Management → Configuration → Content Management →
Utilities → JDBC Connection Pools.
2. In the definition of the connection pools, identify the Database Name and make a note of it
for later use. If the variable %DBSID% appears instead of a database name, then you need
to remember the name specified for DBSID in the config_local.properties file.
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2.1.3

Determining System IDs

Use
You need to find out the system ID on the source system and make a note of it. Later, when you
have completed the migration, you need to delete the ID on the target system because it is
obsolete. The NW ’04 target system uses new IDs.

Cluster only:
In a cluster there are several system IDs. This means you note down several IDs on
the source system for deletion on the target system.
Procedure
...

1. On the source system, log on to the portal and choose System Administration → System
Configuration → Knowledge Management → Configuration → Content Management →
Global Services → System Landscape Definitions → Systems → Content Management
Systems.
2. For later use, make a note of all the system IDs that are displayed.

2.1.4

Pre- Migration Universal Worklist Steps

Purpose
The steps listed below must be performed before migrating Universal Worklist (UWL) information
from Enterprise Portal 6.0 SP2 to NetWeaver ’04.
If only the portal is installed on the source system and you have configured the UWL
according to SAP Note 688830, the configuration is lost during the migration. After the
migration you need to manually reconfigure the UWL on the target system.
SAP Note 688830 explicitly states that SAP does not officially support the configuration of the
UWL if Content Management and Collaboration are not installed.
Procedure
On the EP 6.0 SP2 system:
...

1. Note down the UWL System Configuration details (the system alias and connector
information).
The navigation path is System Administration → System Configuration → Knowledge
Management → Configuration → UWL Configuration → UWL Systems Configuration.

You may take a screenshot or copy the system alias and the corresponding
connector information.
2. Make sure that the User Management information, the SAP R/3 system landscape and
system alias information has been backed up during the portal migration.
Procedure:
a. Navigate to System Administration → System Configuration → System Landscape.
b. Under Portal Content find the systems to which UWL is connected to. These
systems can be under a certain folder or directly under the Portal Content node.

ABCCLNT000 under the folder name UWLTestSystems.
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c. Right-click on the system name and choose Open → Object.
d. Select User Management under the dropdown menu Property Category.
e. Note down the User Management information from the Logon Method (UIDWP,
SAPLOGON or X509CERT)and the User Mapping Type.
f. To display the system alias, select System Alias in the Display dropdown menu.
Note down the system alias for the corresponding system name.
3. Download the XML customization files.

This step is not required if you did not upload any customization file. Do not
download any XML configurations with "(Low)" priority - these configurations were
generated and will be regenerated during the post migration.
Procedure:
a. The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Universal Worklist Content Configuration.
b. Select Display or Remove Current Configurations and Their Customizations.
Choose Start.
c. Select configuration from the dropdown menu options and choose Download XML.
d. Save the file to your local system..

Previous personalization are not preserved after the migration.

2.1.5

Obtaining the Migration Software

Use
You download the software for the migration from the SAP Service Marketplace.
Procedure
...

1. Access the migration software at service.sap.com/swdc → Download → Support
Package and Patches → Entry by Application Group → SAP NetWeaver → SAP
NETWEAVER → SAP NETWEAVER 04 → EP Migration → NW04 SR1 EP 6.0
MIGRATION.
2. Download the file KMC60MIGTOOL_<number>.sar
Where <number> indicates the version of the tool.
Extract the contents to a local machine using the SAPCAR tool:
sapcar –xvf KMC60MIGTOOL_<number>.sar
3. Copy the following file to a temporary directory on the source system:
migrationInfoExporter.zip
Copy the following file to a temporary directory on the target system
migrationTool.zip
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2.1.6

Obtaining and Applying Patch 3

Use
You apply patch 3 for Content Management and Collaboration SPS09 on the target system to
prevent inconsistencies in the configuration. Without the patch, Collaboration does not function
properly in the migrated system.
Procedure

You install patch 3 for SPS09 before the KMC migration and again after the portal
migration. The re-installation is necessary because the migration process includes
the redeployment of software elements.
Download the patch from the SAP Service Marketplace to a local directory on the target system.
Then unpack it with the SAPCAR tool and install it using the Software Delivery Manager (SDM).
For detailed information about downloading and installing the patch, see SAP Note 810454.

2.1.7

Shutting Down the Portal

•

On the source system, make sure that all users have saved and checked in their
documents and are logged off.

•

On the source and target system, shut down the portal. To do this, you stop the J2EE
Engine. Leave it shut down on both systems until the end of the Knowledge Management
and Collaboration migration.

•

Cluster only:
Make sure the portal is shut down on all the nodes in the cluster.

2.2

Backing up the etc Directory on the Target System

Use
On the newly installed NW04 target system, back up the etc directory containing system data.
You need this backup if the migration of the etc directory fails. The backup enables you to
restore the original state so that you can repeat the migration.
Procedure

Cluster only:
Perform this step on the central instance.
...

On the target system, back up the etc folder.
Windows:
\usr\sap\<system_name>\SYS\global\config\cm\etc
UNIX:
/usr/sap/<system_name>/SYS/global/config/cm/etc

2.2.1 Copying Data for Local fsdb Repositories
Use
fsdb repositories store resources on the file system and metadata for these resources on the
database. The data in the database is automatically transferred to the target system during the
database migration. However, the data on the file system is not transferred automatically. If it is
stored in a local directory, you need to copy it manually to the target system.

If the file system data for an fsdb repository is stored on a remote share, no special
copy operation is necessary.
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Copying File System Data to the Target System
For each local fsdb repository that you want to use on the target system:
1. Create a directory on the target system.
2. Compress the data on the source system and then copy it to the newly created directory on
the target system.
3. Unpack the data on the target system.
4. For later reference, note down the name of each fsdb repository and its root directory on
the target system.
You need the information later during the last phase of the database migration. In this
phase, you adapt the configuration settings of the fsdb repositories so that they are valid for
the target system.

2.2.2

Running the Migration Exporter Tool on the Source
System

Use
You run the Migration Exporter tool to:
1
Export the configuration data
2
Collect data on the source system which is required as input for the migration
The Migration Exporter tool saves both the configuration and input data in an archive file
MigrationInput.zip. The data is required later, on the target system, as input for the KMC
Migration Tool.
Procedure

Cluster only:
Perform this step on the central instance.
...

1. On the source system, extract the file MigrationInfoExporter.zip tool to a temporary
folder. You downloaded this file from the SAP Software Distribution Center in preparation
for the migration.
Run the tool from the temporary folder. To do this, enter one of the following commands:
WINDOWS
MigrationInfoExporter.cmd
UNIX
./MigrationInfoExporter.sh
The Migration Exporter tool starts, exports the configuration data and further system data to
the file MigrationInput.zip.
2. Remember the location of the MigrationInput.zip file. Later, you copy the file to the
temporary folder on the target system where the KMC Migration Tool is located.
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2.3

The KM Migration

Purpose
You perform the main steps of the migration with the KMC Migration Tool. You use the tool to run
reports that return information about the system, to merge the contents of the EP 6.0 and NW ‘04
etc directories, and to migrate both the database and configuration.

2.3.1

Using the Migration Tool

Use
You perform all the central migration tasks with the KMC Migration Tool. You run the tool on the
target system.
Procedure
Starting the Tool

Cluster only:
You run the migration tool on the central instance of a J2EE cluster.
On the target system proceed as follows:
...

1. To ensure that you have the authorizations required for the migration, we recommend that
you log on as SAP J2EE Engine administrator.
2. Extract the file migrationTool.zip to a temporary directory. You downloaded this file
from the SAP Software Distribution Center in preparation for the migration.
You can use any extraction tool, for example, WinZip.
3. Copy the file MigrationInput.zip, which contains the input data for the migration, from
the source system to the temporary directory you created in the previous step.
4. Start the KMC Migration Tool.
a. UNIX only: Before you can run the tool, you need to set the execute permission with
the command:
chmod 777 <file_name>
b. To run the tool, switch to the temporary directory and start the script appropriate for
your operating system.
For Windows start:
go.cmd
For UNIX start an X-Session and enter:
./go.sh
The tool opens and offers you all the options that you need to carry out the migration:
Reports, ETC, DB and Config.
Working with the Tool
...

1. When the tool opens, you specify the SAP System Name (SAPSID) to enable access to all
required information during the migration,

FP8
2. Enter a valid registration key in the Registration Key field. To acquire a registration key,
follow the instructions written in SAP Note 854791.
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3. Work through the options in the sequence shown on the initial screen:
a. Reports
b. ETC
c. DB
d. Config
Before you start a new migration step, always check whether the previous step has
completed. If you start a step before the previous one has completed, the data on the target
system will be inconsistent.
For details about each step, see the sections below.
Log File
While the tool is running it writes information to the log file KMCMigrationTool.log which is
located in the directory where you start the migration tool.

2.3.2

Running Reports

Use
The KMC Migration tool includes a number of reports that you run to identify additional actions
that you perform to complete the migration. You run the reports at the beginning of the migration,
but perform the additional actions later after completing the portal migration.

The target KMC system may not start up if you do not perform the steps specified in
the results of the reports after the completion of the portal migration.
Repository Managers Report
This report identifies tasks that are necessary to configure repositories on the targets system
correctly. You need the results of the report later, after the migration of the Portal Platform, to
manually configure the repositories.
For more information, see Performing Tasks Identified by Reports [Page 41]
The report finds out, for example, whether:
•

Local paths and remote paths are accessible and the parameter LocalRoot has a valid
value

•

The LocalRoot Versioning has a valid value for CM repositories

•

W2K Security Manager is in use. On UNIX the report issues a warning.

If you do not want to use the repositories that are configured on the source system
on the target system, you do not need to run the report.
Customer Components Report
The report identifies components that were developed and integrated in the application after the
original installation. These customer components are not transferred to the target system
automatically during the migration and must therefore be transferred manually. You need the
results of the report later, after the migration of the Portal Platform, when you manually
transfer customer components to the target system. For more information, see Performing Tasks
Identified by Reports [Page 41].

If the source system has customer components, the migrated target system will
show errors related to these components. You can temporarily ignore these errors
until after the portal migration when you deal with the migration of these
components. However, make sure that you only ignore errors which are related to
the customer components which are identified by the report. If you notice other
errors, you need to resolve them.
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Database Deployment Report
The report determines whether the CM repositories on the source system store data in more than
one database. This check is necessary because only one database instance is permitted on the
target system. All data for CM repositories is stored in the Java schema of a single SAP J2EE
Engine database instance.

If the tool finds out that more than one database is in use, you need to contact SAP
support to get special assistance for the migration.
Procedure
To run a report, proceed as follows:
...

1. On the initial screen of the KMC Migration Tool, choose Reports.
The Report Tool window opens.
2. Specify a folder to store the results of the reports in the field Save reports results into.
3. Select the report you need to execute and choose Run.
The report starts and writes status information on the screen. Errors are indicated in red.
4. Analyze the results of the report. You open the results in the folder you specified earlier or
with File → View latest Report.
5. If the Customer Components or Repository Managers report contains information that
makes further migration steps necessary, perform these when you have run all the options
offered by the KMC Migration Tool and migrated the portal.

2.3.3

Merging the Contents of the etc Directory

Use
In this procedure, the contents of the old (EP6.0) and new (NW ‘04) etc folders are merged and
copied to the target system.
Procedure
...

1. On the initial screen of the KMC Migration Tool, choose ETC.
The ETC Migration window opens. It shows the Source Folders (EP6.0), the Target Folders
(NW ‘04) and a Temporary Folder. The Temporary Folder is a working folder that shows the
merge process.
2. Choose Start.
The merge process begins. You can follow the progress in the displayed folders and the
output displayed at the bottom of the window. The time that has elapsed for the merge is
shown in milliseconds. When the process has finished the following message appears:
Etc directory migrated successfully in <milliseconds>

If you need to repeat the merge, you can restore the original etc directory on the
NW ‘04 target system using the backup you made in preparation for the migration.
For more information, see Backing Up the etc Directory on the Target System [Page
22].

Migration of SAP Enterprise Portal 6.0 to NetWeaver '04

26

2.3.4

Migrating the Database

Use
You run the Database Migration tool to automatically migrate the EP6.0 source database to the
NW ‘04 target database. In addition, if the migration process includes fsdb repositories, you use
the tool to synchronize these repositories on the target system.
Prerequisites
On the source and target system make sure that the portal is shut down and the database is
running.
Procedure
To migrate the database:
...

1. On the initial screen of the KMC Migration Tool choose DB.
The DB Migration window opens.
2. Enter the required data as shown in the input table below and then choose Start.
When the migration begins, the bottom part of the screen shows the progress of the
conversion and reports any errors that occur. The time required for the migration varies,
depending on the processing power of the target machine. Normally the process takes
several hours.
3. If fsdb repositories exist on the source system, perform the fsdb synchronization. The FSDB
Synchronization screen, which you require for this task, appears after completion of the
database migration. For the synchronization you:
a. Adapt the configuration settings of the fsdb repositories so that they are valid for the
target system
b. Perform the synchronization which ensures that data on the file system and
metadata on the database are synchronized.
Input for Database Migration Tool

If you are uncertain of the DB user and password, which you have to enter, you can
test it as follows:
Oracle
Open the Enterprise Manager Console with Start → Programs → Oracle →
Enterprise Manager Console. Choose the instance and enter username and
password for CM. If the logon fails, you might need to enter a new password.
MS SQL Server
Open the Query Analyzer with Start → Programs → Microsoft SQL Server →
Query Analyze and use SQL Server Authentication. Enter the user and password for
the CM database. If the login fails, you might need to change the password.
For more information on setting a new password for Oracle or MS SQL Server, see
SAP note 687576.
Source
DB Server

Enter the IP Address of the machine where the source database
server is installed.
To find out the address enter the command:
netstat –n

DB Type

Enter SQL Server or Oracle.
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DB Name

Enter the name of the database. This can be the default wcm or
the name you determined earlier in the connection pools or the
DBSID entry of the config_local.properties file. For more
information, see Determining the Database Name [Page 19]

DB port

For MS SQL Server: Enter the port number for the database.
The default is 1433.
For Oracle: Enter the Listener port for the database. The default
is 1521 or 1527.

DB User

Enter the user with which CM connects to the database.
The MS SQL Server default user is wcm
The Oracle default user is wcm.

DB Password

Enter the password for the CM database connection.

Synchronizing the fsdb Repositories
You perform the synchronization at the end of the database migration, when the FSDB
Synchronization screen appears. The synchronization ensures that the fsdb data on the file
system corresponds with the metadata in the database.

To prevent the loss of fsdb metadata on the target system, you must perform the
synchronization at this point in the migration process.
Proceed as follows:
1. In preparation for the synchronization, configure the fsdb repositories correctly for the target
system. To do this:
a. Select a repository that is displayed on the FSDB Synchronization screen.
The color in which the root repository is displayed changes to green, red or orange.
b. In the table below, find out the meaning of the color and then perform the actions
that are recommended to correct the configuration.
Color

Meaning

Required Action

Red

The root directory that is specified for
fsdb data on the source system does
not exist on the target system.

Click on the path displayed in red and
navigate to the correct directory on the
target system. You created this directory
in preparation for the migration.

Orange

The root directory that is specified exists
on the target system, but does not
contain the data for the fsdb repository
which is selected on the screen.

Click on the path displayed in orange
and navigate to the directory on the
target system which contains the data
for the repository in question. You
created this directory in preparation for
the migration and then filled it with fsdb
data from the source system.

Green

The repository involved is configured
correctly on the target system

No action

Black

The repository involved is not selected.
Colors indicating the validity of the
configuration are not displayed.

No action
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2. Synchronize the data on the files system with the metadata on the database. To do this:
a. Select all the fsdb repositories for which you copied data from the source to the
target system.
b. Click Start to trigger the synchronization process.
The process takes few minutes to complete. When it has finished, you are informed
in the status area of the FSDB Synchronization screen.

2.3.5

Migrating the Configuration

Use
The migration of the configuration merges the EP6.0 and NW ‘04 configuration data and transfers
it from the file system to the database.
Procedure
...

1. Close any explorers or applications that are open and can access directories with
configuration data.
2. On the initial screen of the KMC Migration Tool, choose Config.
The KMC Configuration Migration window opens.
3. Choose Run. The migration begins and displays the status at the bottom of the window.
Errors are displayed in red.
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3

Portal Migration

This migration moves and processes portal 6.0 content to make it compatible with J2EE Engine
6.40, thereby enhancing its infrastructure and bringing it in line with NetWeaver ‘04. The migration
tool is a separate utility implemented by SAPInst.
The migration is an automated process, but requires some manual, preliminary steps as well as
important post-migration procedures.

If your system includes KM, the migration for KM must be performed before the
portal migration. For migrating Knowledge Management (KM), there are different
tools and processes than for the portal. For more information, see Knowledge
Management Migration [Page 17].
For the latest information and updates about the migration process from EP 6.0 SP2 to NW ‘04,
consult SAP Note 732458.
Prerequisites
•

You are running SAP Enterprise Portal 6.0 SP2 with the patch level indicated in the central
note for the EP 6.0 to NW ’04 migration (732458). This is the start version of the portal from
which you are migrating. If you are running an earlier EP 6.0 version, then upgrade your
portal accordingly.

•

The NetWeaver ‘04 portal is installed on your target machine. This is the portal to which
your SP2 content is migrated.

The target NW ’04 portal must be installed as a standalone J2EE Engine—not as an
add-in to an R/3 system and not with R/3 persistence. For detailed information, see
SAP Note 780679.
•

If your NW ’04 installation works with an Oracle server, see the pre-migration activity,
Installing a Configured Oracle Administrative Client [Page 34].

•

If your NW ’04 installation is on a Unix machine, you need to also set the following
environment variables: JAVA_HOME and DISPLAY.

•

Java Virtual Machine (JVM) settings are configured as recommended in SAP Note 723909.

Process Flow
Although most of the migration of the content from the EP 6.0 SP2 machine is automatic, some
manual steps are involved in preparation for migration.
To prepare for automatic migration you must do the following:
•

Perform all require pre-migration activities. See Preparing for the Portal Migration [Page 31]
for details.

•

Shut down the EP 6.0 SP2 the source system.

•

Run the migration utility as described in Migrating the Portal [Page 37].

•

Perform post-migration activities. See Post-Migration Activities [Page 40] for details.
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3.1

Preparing for the Portal Migration

Before migrating the old system to the new one, several preparation steps are required. Follow
the instructions described in the sections below. The following topics are included:
•

Preparing User Management Configuration for Migration [Page 31]

•

Installing a Configured Oracle Administrative Client [Page 34] (If working with Oracle
database server)

3.1.1

Preparing User Management Configuration for Migration

All usermanagement data created before migration on J2EE Engine 640, if any, will be deleted.
Only the admin and guest users and the admin and guest groups will remain in the installation,
unless they are replaced by the SP2 data, if such data is available. See the table below for the
various possible flows, and specific recommendations where necessary.

The following principals (users and groups) may exist in the source EP 6.0 SP2
portal:
“Administrator” user
“Guest” user
“Administrators” group
“Guests” group
If they exist in EP 6.0 SP2 in the same case (Title Case) as they appear here, these
users and groups will be migrated to the NW ’04 portal.
These principals must not appear in any other case (UPPER, lower) in EP 6.0l SP2
portal. If such principal data (in an unsupported case) is found during the migration
process, the migration will stop.
In order to avoid mistakes, we recommend not having these principals at all in the
EP 6.0 SP2 portal.

The user “Administrator,” whether created upon installation of NW ’04 or migrated
from EP 6.0 SP2, is added automatically, by the migration process, to the group
“Administrators,” receiving all the permissions associated with that group. The
migrated “Administrator” user also will always take on the password of the existing
NW ’04 SR1 user.
After reading the following information, see Downloading the User Management Configuration for
Migration [Page 33] for information on how to download the user management information for
migration.
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UME information – flow at back end
Source of User Information

Back-End Flow and Recommendations

Database only

If no admin or guest users (“Administrator” / “Guest”) exist in the
EP 6.0 SP2 database, the users and their respective passwords
from the NW ‘04 installation are used.
If any users (“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) exist in the EP 6.0 SP2 database,
this is the data that will be used for NW ’04.
For the “Administrator” user, the password from the NW ‘04
system will be taken. This user will be mapped to the
“Administrators” group during the migration process.

LDAP

If no admin or guest users (“Administrator” / “Guest”) exist in the
EP 6.0 SP2 database, the users and their respective passwords
from NW ‘04 installation are used.
If any users (“Administrator” / “Guest”) and groups
(“Administrators” / “Guests”) exist in the LDAP, these LDAP
users and groups will not be used in NW ‘04 after the migration.
This data will be masked in NW ‘04 to avoid data inconsistency.
The database users and groups from NW ‘04 will be used
instead. These users and groups might not have the same role
mappings or permissions as in EP 6.0 SP2.

To avoid possible data and permission
inconsistency, please make sure that you do not
use the users (“Administrator” / “Guest”) and groups
(“Administrators” / “Guests”) from your LDAP
directory in your EP 6.0 SP2 portal before
migration.
SAP System

If no admin or guest users (“Administrator” / “Guest”) exist in EP
6.0 SP2 database, the users and their passwords from NW04
installation are used.
If any users (“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) exist in the EP 6.0 SP2 database,
this is the data that will be used for NW ’04.
For the “Administrator” user, the password from the NW ‘04
system will be taken. This user will be mapped to the
“Administrators” group during the migration process.

Please make sure that you do not have any users
(“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) in your SAP System
before migration.
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3.1.2

Downloading the User Management Configuration for
Migration

Use
SAPInst cannot extract the user management information from the EP 6.0 SP2 database. You
must download this information from the source portal to a .zip file, the location of which is
supplied to SAPInst for the migration.
Prerequisites
•

You are running EP 6.0 SP2 with the latest patch as indicated in the central SAP Note for
EP 6.0 SP2 migration (732458)..

•

You have read Preparing User Management Configuration for Migration [Page 31].

Procedure
...

1. From the top level navigation of the EP 6.0 SP2 portal, choose System Administration →
Support. Support Desk appears in the detailed navigation.
2. Under Top Level Areas in the work area, choose User Management. The Portal Support
Desk opens for User Management.
3. Under Test and Configuration Tools, choose Status of UME properties. The User
Management Configuration View appears.
4. Choose the Configuration Download tab.
5. Select the Download migration zip file checkbox; then enter and confirm a password of at
least eight characters.
6. Click Download Files and save the file to disk.

The password you define and the location to which you save the files will be
required later for the SAPInst migration.
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3.1.3

Preparing for Migration with an Oracle Database

If the target NW ’04 system is running with an Oracle database, you must take a number steps to
ensure a successful migration.
Installing a configured Oracle Administrative Client
If the Oracle server is not on the target machine (which is typically the case), an Oracle
Administrative Client must be installed and configured on the target machine.

Verify that the Oracle user on the source system (EP 6.0 SP2) has the same grants
and permissions as the the Oracle user on the target system.
•

If any grants and/or permissions for the Oracle user on the target system are
missing for the Oracle user on the source system, add them on the source.

•

If there are grants and/or permissions for the Oracle user on the source
system that do exist for the Oracle user on the target system, remove them
from the source.
For example, if the Oracle user on the source machine has the DBA User
role, remove it.

Set environment variable on Unix
For Unix machines only, set the environment variables ORACLE_HOME, PATH, and
<LIBRARYPATH>.
<LIBRARYPATH> is the environment variable assigned to your operating system that determines
the search path for Shared Libraries. This variable is named on different Unix flavors as follows:
•

AIX – LIBPATH

•

Tru64 UNIX, Reliant UNIX, Solaris, Linux – LD_LIBRARY_PATH

•

HP-UX – SHLIB_PATH

The variables PATH and <LIBRARYPATH> are dependent on the variable ORACLE_HOME. See the
following examples for setting these variables and their values.
Example of Oracle Administrative Client setup for cshell:
setenv ORACLE_HOME /oracle/client
setenv PATH $ORACLE_HOME/bin:$PATH
setenv LD_LIBRARY_PATH $ORACLE_HOME/lib
Go to SAP Note 539922 for more explanations about Oracle 9.2.x installations.
Verify database instance aliases in TNSNAMES.ora (Windows and Unix)
TNSNAMES must be configured correctly to recognize the databases on the source and target
machines.

The database instance aliases in TNSNAMES.ora must be entered according to the
following convention: <SID>_<hostname>, for example POR_ilsun31.
Test TNSNAMES
Test DB connections on the target machine where the Oracle client is configured. To verify that
the database instance aliases in TNSNAMES.ora are properly configured, run the tnsping
command, as follows, <tnsping <SID>_<hostname>>, from the Command Prompt terminal on
Windows, or a shell terminal on Unix.
Run tnsping to the aliases of both <SOURCE DB> and <TARGET DB>.
If the output is returned without errors, TNSNAMES.ora is properly configured. If errors are
returned, consult your DBA for assistance.
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Configure database instance aliases in TNSNAMES.ora (Windows and Unix)
On Windows
...

1. Open the Oracle Net Manager utility (from the Windows Start menu, Programs → Oracle →
Configuration & Migration Tools → Net Manager), and go to Local → Service Naming.
2. With Service Naming selected, choose the plus sign (+) icon and follow the wizard. Make
sure to add the database instance aliases of both the <SOURCE DB> and <TARGET DB>.
Be sure to test the use the wizard option for testing the connection when finished.
On Unix
On Unix, you must add the database instance aliases of both the <SOURCE DB> and <TARGET
DB> to the TNSNAMES.ora file using any text editor. See the following sample: (Note how, in this
example, the convention for the database instance name is followed, where <SID> = POR;
<hostname> = ILSUN31.)
Also note that the Oracle domain is defined as WORLD, and the alias must be written with the
domain name as in the example:
POR_ILSUN31.WORLD =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = ilsun31)(PORT = 1527))
)
(CONNECT_DATA =
(SID = POR)
(SERVER = DEDICATED)
)
)
POR_ILSUN30.WORLD =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = ilsun30)(PORT = 1527))
)
(CONNECT_DATA =
(SID = POR)
(SERVER = DEDICATED)
)
)

It is strongly recommended that the manual update of TNSNAME.ora be performed
by a DBA.
Be sure to test the connection using tnsping, after configuration.
classes12.jar
Prior to migration, verify on the target NW ’04 SR1 machine, that the file classes12.jar exists at
…/usr/sap/JC<J2EE_instance_number>/j2ee. If not, copy this file from the oracle client
installation folder (for example, …\oracle\j92\920\jdbc\lib\classes12.jar) to the above location.
Check the properties of this file to verify that the user who performs the migration (that is, the one
who runs SAPInst) has permissions for it. On Unix, execute permission is required.

Backing up both the <SOURCE DB> and <TARGET DB> is strongly recommended.
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3.1.4

Verify/Preconfigure SDM

A possible cause of failure in the midst of the migration process is if a specific SDM property,
which is not set correctly on the target system for starting and stopping the J2EE Engine during
the deployment of SDAs.
For details about how to configure the SDM in order to prevent this from occurring, see SAP Note
795142.
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3.2

Migrating the Portal

Use
Running the migration utility processes and imports your EP 6.0 SP2 content, preserving it for use
after moving to NetWeaver ‘4.0 SR1.
Prerequisites
You have complied with all the requirements to prepare for the migration, as described in the
“Prerequisites” and “Process Flow” parts of Portal Migration [Page 30].
Procedure

Warnings:
•

In order to maintain data consistency, EP 6.0 SP2 must not be running during
the migration process.

•

To avoid the possibility of database corruption, do not stop the migration
process, by choosing Cancel, at any time while SAPInst is running. only if it
stops automatically.

•

Verify that the password for the Administrator user, which you are required to
provide in SAPinst (see step 2), is also the password for the Software
Deployment Manager (SDM).
If necessary, this can be checked by verifying the Administrator password in
the J2EE Engine Visual Administrator tool, and then providing the same
password for the SDM.

...

1. After starting the target portal, download the migration tool from the Software Download
Center on SAP Service Marketplace, service.sap.com/swdc → Download → Support
Package and Patches → Entry by Application Group → SAP NetWeaver → SAP
NETWEAVER → SAP NETWEAVER 04 → EP Migration, to some location on the target
NW ’04 machine.
2. At the migration tool location on the target machine, navigate to the SAPINST directory.

The user that runs the migration utility must have the same permissions as the user
that ran the installation of the target NW ’04 SR1 portal:
•

On Windows OS, user <SID>admin (for example, A30adm) is recommended

• On Unix, this must be the root user
If the target system OS is Windows:
{

Continue navigation to NT → I386, and run sapinst.exe.

If the target system OS is Unix or Linux:
{

Continue navigation to UNIX → <OS_name>, and run sapinst.

At this point, the migration tool starts the J2EE Engine on the target system, if it is
not already up and running.
3. In the SAP Web AS Java System screen, choose from the selection list the J2EE instance
on which your target NW ’04 SR1 portal is running, and enter the account details of the
J2EE administrator. (This information was defined when the NW ’04 portal was installed.)
Choose Next.
{
For Windows, go to step 4.
{
For Unix, skip to step 5.
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4. In the Registration screen, enter a valid registration key and choose Next.
If you do not have a registration key, obtain one by following the instruction in SAP Note
894791.
5. Enter the system administrator password in the SAP System Administrator Authentication
screen, and then enter either the Windows domain or local machine name, whichever is
appropriate. Choose Next.
6. In the next screen, enter the details of the UME zip file you downloaded from the portal on
the source EP 6.0 SP2 machine.
For locating the zip file, there is a browse option. The password was defined when the UME
zip file was downloaded from the source portal.
For details, see Preparing User Management Configuration for Migration [Page 33].
7. In the following two screens, enter the database connection details of your EP 6.0 SP2
portal and your NW ’04 portal respectively.

Make sure that you enter the source database information for the Portal Content
Directory (PCD), and not the KM (WCM) database.
For the NW ’04 portal, just enter a password, since the other details are of the current
system and are known. All of the database connection details need to be supplied for the
source portal.
Choose Next to open Summary screen and to start the migration process.
8. Migration begins and the Migration Progress screen appears, which displays the progress
of the migration phases, and the overall progress in a progress bar at the top of the screen.
Choose Log to view the migration log file in the event of problems during migration.
A notification appears upon successful completion of the migration.
If errors occur during the migration process, choose View Log to find out the details of the
problems. After verifying the cause of the error, several options are offered by the SAPinst
wizard that runs the migration. For an explanation of these options, see the table below.
For more information about the log file locations, see Checking the Status of the Portal
Migration [Page 49].
SAPinst Display Options
The following buttons are available on the different SAPinst dialogs, namely the input screens
installation progress screen and the message boxes:
Button

Meaning

Back

Displays the previous dialog for editing

Next

Displays the next dialog for editing
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Cancel

Cancels the installation with the following options:
Stop
Stops the migration and leaves the migration files in the state in which
they are at the current point in time. This allows you to continue the
migration later from this point.

Be aware that stopping the migration process manually may result in
corruption to the target system database.
Reset
Resets all migration input files. All files in the installation directory are
removed from the system and no log files are saved. You will have to
start the installation from the beginning again.
Continue
Returns to the installation.
Logoff

Exits the SAPinst dialog only. The SAPinst installation keeps running.
Typical use case:
You need to logoff during the installation from the host where you currently
control the installation, in order to connect from another host to the running
installation. Be aware that you need the installation DVD for that.

View Log

Displays the content of the sapinst.log file during the installation.

Retry

Performs the installation step again (if an error has occurred).
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4

Post-Migration Activities

For the migration process to be complete for both KM and the portal, certain post-migration
activities must be performed after the successful implementation of the respective automatic
migration tools.

4.1

Post-Migration Activities for KM

Purpose
To complete the migration, you configure repositories and migrate customer components with the
help of the information generated by the migration reports. You also delete obsolete system IDs in
the cluster and determine if it is necessary to reassign users to NW04 roles.

4.1.1

Deploying KM Software Components

Although migrating from EP 6.0 SP2 to NW ’04 requires that the Knowledge Management
migration is performed before the migration of the portal, the nature of the portal migration forces
the redeployment of all KM software components as a post-migration activity.

If KM is installed with the portal, this must be the very first post migration activity to
be performed.
...

1. This is performed using the Software Deployment Manager (SDM). The SDM, including
related documentation, is to be found at the following portal installation path:
/usr/sap/SYS_ID/JCxx/SDM/Program
You need to run the following programs to open the SDM:
{
StartServer.bat for Windows or StartServer.sh for Unix
{
RemoteGui.bat/.sh
If running on Unix, you need an X-terminal for the RemoteGui.sh.
2. Before deployment, reconfigure the deployment configuration settings of the SDM as follow:
a. In the SDM, go to the Deployment tab and choose the Show Deployment
Configuration arrow on the bottom right of the UI screen.
b. Under Deployment Configuration, choose the setting option: “Update deployed
SDAs/SCAs that have any version.”
3. Locate the KM software components s on the NW ’04 SR1 installation DVD, in the folders
at …\EP-KMC\.
Choose and redeploy all the software components in these folders.
4. To shut down the SDM server properly, you need to run StopServer.bat/.sh.
5. Restart the J2EE Engine.
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4.1.2

Performing Tasks Identified by Reports

Use
Use the information generated by the Customer Components and Repository Managers reports to
perform additional manual migration steps.
Procedure
...

1. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and open
the report for the Customer Components. Alternatively, you can access the reports directly
in the folder which you specified for the results.
The Customer Components Report helps you to identify components which were
developed after the original installation and which you must therefore migrate manually. It
shows a list of xml configuration files that exist on the target system without a
corresponding java class. The java class is missing because the normal migration
procedure only transfers the xml files of customer components and not the corresponding
java classes. Content Management displays errors on the target system if it registers that
xml files point to java classes that do not exist in the system. To deal with customer
components you have two options. You can:
{
Deploy the java classes of customer components on the target system
{
Delete the xml configuration files of customer components on the target system.
Only do this, if you are certain that these components are not needed on the
target system. The deletion ensures that no errors are displayed in the system.
If you delete the xml files, some may still be referenced and cause errors on the
target system. Keep in mind that you need to deal with this problem as well.
2. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and open
the report for the Repository Managers. Alternatively, you can access the report directly in
the folder which you specified for the results.
With the help of the report, identify problems related to the configuration of repositories on
the target system and resolve them with the instructions provided. Due to the move from
one machine to another, the configuration of some repositories is no longer valid. For
example, if you have configured a local repository on the source system, then the path to
the repository will no longer be correct on the target system. The report informs you of the
tasks that are necessary to configure the repositories correctly.

4.1.3

Deleting System IDs

Use
After the migration, the system IDs of the old EP 6.0 system and the new NW ’04 system are
active in the configuration. You therefore need to delete the obsolete EP 6.0 system IDs.
Cluster only:
After deleting the old system IDs, you make sure that scheduled tasks are assigned to the new
IDs.

If both the old and the new system IDs are active, an error appears in the
component monitor. To check for the error in the portal, choose System
Administration → Monitoring → Knowledge Management → Component Monitor
KMC → Component Monitor → Services → Landscape Service:
Configuration Error: Cluster mode not enabled
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Procedure
...

1. Log on to the portal and choose System Administration → System Configuration →
Knowledge Management.
2. Choose Content Management → Global Services → System Landscape Definitions →
Systems → Content Management Systems.
The system ID is displayed.
3. Delete the EP 6.0 system ID. You made a note of it in preparation for the migration.
Cluster only:
In a cluster configuration with several instances:
a. Delete all the system IDs that originate from the source system. You made a note of
these in preparation for the migration.
b. Assign scheduled tasks to the new system IDs.

You must explicitly assign tasks to a system ID, otherwise they are not executed.
To assign tasks:
i. Return to Global Services and choose Scheduler Tasks.
A list of scheduler tasks is displayed.
ii. Make sure that the tasks listed are all assigned to the new NW ‘04 system
IDs. Change any assignment that still uses old system IDs.

4.1.4

Post-Migration Universal Worklist Steps

Purpose
The steps listed below must be performed after migrating Universal Worklist (UWL) information
from EP 6.0 SP2, and above, to NW 04 SR1.
Procedure
On the NW ’04 SR1 system:
...

1. Re-enter the information in the UWL System Configuration.
2. Re-register the item types for UWL system from the UWL admin page.
The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Registration for Item Types of Universal Worklist Webflow.
3. Re-upload the customization XML.
The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Universal Worklist Content Configuration.
Additional Information
If you have the Manager’s Self-Service (MSS) installed on your system, see SAP note 646601 for
further details.

The Workflow Execution Handler (Workflow XHandler) is no longer supported as
of the following Business Packages for Manager's Self-Service (MSS):
MSS 50.2.6 or later
MSS 50.3.4 or later
MSS 50.4 or later
MSS 60.1 or later
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4.1.5

Post-Migration Workflow Steps

Purpose
The steps listed below must be performed after migrating Workflow information from EP 6.0 SP2
to NW ’04.

No pre-installation steps are required.
Procedure
After the migration, start the portal.
...

1. Navigate to System Administration → System Configuration → Knowledge Management →
Workflow- Engine. Edit the following attributes:
Database Type = openjdbc
Factory = com.sap.engine.services.jndi.InitialContextFactoryImpl
2. Stop and restart the portal.
3. Initialize Workfllow template. See details below.

4.1.6

Initializing Workflow Templates and Object Types

Use
To enable the use of templates and object types in Ad Hoc Workflow, you need to manually
initialize them.
Procedure
...

1. Log on to the portal and access the workflow templates with Content Administration →
Workflow Content → Workflow Templates.
2. Choose Restore Default Templates.
For Windows:
The default workflow templates are automatically initialized.
For Unix systems:
a. The default templates are not automatically initialized. You must upload the template
manually. The template XML files are available in the following directory:
\usr\sap\<SAPSID>\JC<number>\j2ee\cluster\server0\apps\sap.com
\
irj\servlet_jsp\irj\root\WEB-INF\portal\portalapps\
com.sap.workflow.apps\ private\install\templates
There are seven XML files to be uploaded:
QuickTask.xml
QuickTaskWithoutApproval.xml
RequestFeedback.xml
RequestFeedbackParent.xml
RequestNomination.xml
RequestNominationAnonymous.xml
RequestNominationParent.xml
b. Navigate to Content Administration → Workflow Content → Workflow Templates.
c. Click Load Template From File and upload the above listed seven XML files.
d. From the list of Available Workflow Templates, click the Activate icon from the Action
column to activate the template
3. To access the object types for tasks, enter the following address:
http://<servername>:<portNumber>/irj/servlet/prt/portal/
prtroot/com.sap.workflow.apps.BusinessObject
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4. Choose Browse and then navigate to the folder specified below.

For UNIX replace the backslashes with slashes.
\usr\sap\<SAPSID>\JC<number>\j2ee\cluster\server0\apps\sap.com\
irj\servlet_jsp\irj\root\WEB-INF\portal\portalapps\
com.sap.workflow.apps\private\install\objTypes
5. Select WFTask.xml and choose Upload.
The object types for workflow tasks are created.
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4.2

Post-Migration Activities for the Portal

Use
To complete the current migration process so that migrated EP 6.0 SP2 content operates
satisfactorily in NW ’04, post-migration steps must be performed for the following components:
•

Systems using R/3 template and Crystal Report server

•

Trust to SAP backend systems

•

Reverse proxy parameters

•

J2EE Engine and Content with Code

•

Editing datasource configuration

•

Upgrading initial permissions

•

Theme Personalization and Miscellaneous Information

•

Installation of latest NW ’04 upgrades

•

KMC SDA deployment

4.2.1

Connecting to R/3 Systems and Crystal Reports

Because of properties created subsequent to the release of EP 6.0 SP2, certain steps are
required for the following circumstances:
•

Access required to SAP systems
Two new system properties, where the EP system object is based on the template
Dedicated Application Server for R/3 System:
{
Gateway Host
{
Gateway Service
Enter the appropriate values for these properties in the system object Property Editor under
the default Information category.

•

Access required to data from the Crystal Report server (such when a BW system needs to
bring data from a Crystal Report server)
Three new system properties, where the EP system object is based on the template
Dedicated Application Server for R/3 System:
{
Host name of Crystal Enterprise Server
{
Path of Crystal Enterprise Server
{
Protocol of Crystal Enterprise Server
Enter the appropriate values for these properties in the system object Property Editor under
the Crystal Enterprise Server category.

To open the Property Editor, go to System Administration → System Configuration →
System Landscape; right-click desired system and choose Open → Object.
If you work these systems, consult SAP Note 726750 for detailed information.

4.2.2

Working with Back-End Systems

If you are using systems in the source portal system landscape, which are based on SAP
backend systems, such as R/3, BW, and CRM, and which are authenticated using
SAPLOGONTICKET, you need to recreate the trust between the NW ‘04 portal and the relevant
SAP backend system.
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4.2.3

Reverse Proxy Filter Configuration

Reverse proxy filter configurations are not migrated from EP 6.0 SP2 to NW ’04. If you configured
a reverse proxy filter for your portal, which ran on top of J2EE Engine 6.20, you need to redo the
configuration for the new portal, now working with J2EE 6.40.
The configuration is entered in the web.xml file, located on J2EE 6.40 at the following path:
…\usr\<SAP_system_ID>\<J2EE_instance>\j2ee\cluster\server0\apps\sap.com\irj\servlet_jsp\irj\r
oot\WEB-INF
The web.xml file on J2EE 6.20 is located at:
…\usr\sap\<SAP_system_ID>\j2ee\<<j2ee_instance>_<port>>\cluster\server\services\servlet_jsp\
work\jspTemp \irj\root\WEB-INF\web.xml
If any other custom changes were made to web.xml in SP2, such as the addition of portal aliases
for logon purposes, these must also be copied to the web.xml file on the NW ’04 machine.

4.2.4

J2EE Engine and Content with Code

...

1. If a connection pool was created in EP 6.0 for custom applications, make sure to recreate it
for NW ’04, as it was defined in J2EE for EP 6.0.
2. If EJBs were created and deployed in EP 6.0, redeploy them in J2EE 6.40 for NW ‘04.
If you have customized content using code, or you are running applications specific to SAP
J2EE Engine 6.20, you may be able to convert these to work with SAP J2EE Engine 6.40
using the SAP J2EE Engine Converter and Deploy tools.
For details, see the section on incompatibilities between J2EE 6.20 and 6.40 in the
migration manual for SAP J2EE 6.20 to 6.40 at help.sap.com/nw4 → English → SAP
Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → Java
Technology in SAP Web Application Server → Migration.
3. If additional JARs were copied to EP 6.0, they need to be recopied to NW ’04.
See the section on incompatibilities between J2EE 6.20 and 6.40 in the migration manual
for SAP J2EE 6.20 to 6.40, if necessary.
4. If you have custom tuning and configuration changes, which were made in J2EE Engine in
6.20, and need to find the corresponding settings and system properties in J2EE 6.40, this
information is also covered in the section on incompatibilities between J2EE 6.20 and 6.40
in the migration manual for SAP J2EE 6.20 to 6.40.
5. If the files library.txt or reference.txt were changed in EP 6.0, the changes must be redone
for NW ‘04.
6. If additional HTML files were created in EP 6.0, copy them to the docs folder on the NW ’04
machine, \j2ee\j2ee_<instance_no>\docs.
7. Deploy proprietary portal archives (PAR files).
{
All PAR files in the source system database are migrated to the target system
database.
{
If you have overwritten PAR files provided by SAP with your own PAR files, using
the same name (in order to enhance or customize functionality), these files will be
overwritten in the target system by the new SR1 PARs. If you want to have your
PARs running in the new SR1 system, you have to manually redeploy them to the
NW ‘04 system after migration.
{
If you have created functionality with new proprietary PAR files in the source system,
in order to replace the functionality of existing files, this may end result in duplicate
functionality in two separate PAR files. In this case, remove one of the two par files.
For deploying and removing PARs, navigate as follows:
i.
ii.
iii.

System Administration → Support → Support Desk.
Under "Portal Anywhere" Admin Tools, choose Administration Console.
Use the Archive Uploader to deploy PAR files, and the Archive Remover to
remove them.
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4.2.5

Editing a Data Source Configuration File for UME
Persistence

The user management configuration needs a datasource file for persistence configuration. If a
proprietary datasource file, that is, a copy of an existing datasource file, was used in EP 6.0, this
file will also be used in NW ‘04. If the user has changed an already existing, SAP-released
datasource file, the changes made to this file will be lost after migration to NW ’04.
If a customized datasource configuration file has to be adapted to NW ’04, see SAP Note 751553
for details about how to do this using the offline J2EE Engine config tool.

It is recommended testing the custom datasource file.

4.2.6

Upgrade the Initial KM Permissions File

After the migration of EP 6.0 SP2 to NW ’04, the KM Security Zone has no initial permissions.
Rectifying this can only be performed after the portal has been successfully migrated.
Perform the steps described in SAP Note 804876.

4.2.7

Theme Personalization, Logging, and Miscellaneous
Properties

Theme Personalization Not Migrated
Users who personalized the theme of their portal, that is, chose a different theme than the portal
default, must choose the desired theme again after migration.
logger.xml Configurations not Migrated
NW04 has new logging mechanism. Logs will be automatically recreated in NW ’04 SR1.
Top-Level Navigation Properties Moved
Three TLN properties were moved in the NW ’04 portal to the navigation.helperservice.
They are ContentArea, InnerPage, PersonalizePortalPage.
If you have changed the values of these properties in the SP2 system, the look and feel of the
NW ‘04 portal be the default as provided by SAP, and not the same as in your EP 6.0 SP2
system. For information about resetting these values see SAP Note 777176.
Copying Property Files
Property files are not be migrated to NW ‘04. For example, iViews based on CRM 3.1 properties
will not run on NW ’04 until the property files copied manually.
PCD Startup Properties
The file pcdStartup.properties is not migrated. Changes made to this file will not be applied to the
NW ‘04 system, for example, the location of the import folder. After migration, the default provided
by the NW ‘04 portal will be applied. See SAP Note 778977 for detailed information.

4.3

General Post-Migration: Installing NW '04
Upgrades

For both the Portal Platform EP 6.0 SP Stack 09 and for Knowledge Management, install the
latest patches, as indicated in the central note for the EP 6.0 SP2 migration (SAP Note 732458).
For the portal patch, download the files available at service.sap.com/swdc → Download →
Support Package and Patches → Entry by Application Group → SAP NetWeaver → SAP
NetWeaver 04 → EP Migration. Use the document Patch Installation Guide: SAP Enterprise
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Portal 6.0 on Web AS 6.40, on SAP Service Marketplace at service.sap.com/instguidesNW04 →
Operations.
For KM, the details of the patch installation are supplied by the relevant SAP Note for the patch
(related to the central note for the migration).
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5

Troubleshooting the EP 6.0 to NW '04
Migration

In the event of problems incurred during the migration process for KM or the portal, check the
status of the process as described in the following sections.

5.1

Checking the Status of the KM Migration

Use
Log on to the target system and check the component monitor to assess the status of the
migration.
Procedure
...

1. In the portal, choose System Administration → Monitoring → Knowledge Management →
Component Monitor.
2. In the component monitor, click Filters, Repository Managers, Repository Services and
Services. For each of these items, check the subentries. Keep in mind that if you have not
yet performed the necessary actions identified by the Repository Managers Report, tool
during the repository check, the repositories will indicate errors:
The colors beside the entries indicate the following:
{
Green shows the object is functioning well.
{
Red shows the object cannot be started or is configured incorrectly.
{
Yellow indicates that one or more lower-level items are red.
3. If Content Management does not start up, there might be a problem with the database
connection. To find out more, check the available log files:

For UNIX, replace the backlashes in the paths with slashes.
...
...

a. Switch to the directory:
<Drive>:\usr\sap\<SAPSID>\JC<J2EE_instance_number>\j2ee\
cluster\server0\log\
b. Open the file defaultTrace.0.trc with the most recent date. If errors appear in
the trace file, try to solve them and then restart the SAP J2EE Engine.

You can also view the trace file using the log viewer that is available in the SAP
J2EE Visual Administrator.

5.2

Checking the Status of the Portal Migration

Since the migration tool is a SAPInst utility, use the SAPInst options, including viewing SAPInst
logs, as described in the section Migrating the Portal [Page 37] in the event of problems during
the migration process.
The disk locations for the SAPinst logs are as follows:
For Windows:
c\program files\sapinst
For Unix:
…\space\sapinst
After the portal migration is completed, the logs can be found under:
<installation folder>\JC<instance
number>\j2ee\portal_misc\MigrationSP2_To_SP9_Logs.
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For additional useful information, see the central note for the EP 6.0 SP2 migration to NW ’04
(732458), and the relevant related notes.
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